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1. 基本知识 

离子色谱仪由以下几个基本部分组成：淋洗液，高压输送泵，

进样阀，分析柱，抑制器和电导池组成。在操作过程中，首先使

用标准溶液对离子色谱仪进行校正，再与样品的数据进行比较，

从而完成对样品离子的定性/定量分析，色谱工作站可以自动计算

样品的谱峰浓度并打印报告。 

 

图 1.原理示意图 

 

1.1 淋洗液的输送 

    *  ICS-90 为等浓度输送系统，即淋洗液的组成和浓度在运

行过程中不发生变化； 

    *  液体样品通过人工注射或自动进样器进入系统； 

    *  泵推动淋洗液和样品流向分析柱。 

 

1.2 分离 

ICS-90 采用离子交换分离柱，根据离子特性（如离子半径，
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电荷数等）的差异造成离子在分离柱中运动速度的不同，从而达

到分离目的。 

 

1.3 检测 

淋洗液和样品通过分离柱后进入抑制器，可以提高检测灵敏

度，再进入电导池，测量其信号响应值。 

 

1.4 数据分析 

ICS-90 将电导池的测量信号输送到运行色谱软件（Peaknet 

6.4）的计算机中，进行样品和标准的谱图对照比较。根据保留时

间定性；峰高/峰面积定量，自动计算分析结果。 

    ICS-90 采用 Peaknet 6.4 数据系统。它采用 USB 方式连接，

可以完成仪器控制，信号采集，数据处理等。预先设定的分析方

法使用户能够迅速得出分析结果。 
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2. 描述 

2.1 操作特性 

2.1.1 前门和顶盖 

 

图 2. ICS-90 外形图 

    ICS-90 的前门设有进样口。顶盖的凹槽用于放置淋洗液和再

生液瓶。显示操作状态的 LED 指示灯功能如下： 

LED 指示灯 状态 说明 

Power Off 电源未接同通 

 On 电源接同通 

Ready Off 仪器未准备好或正在运行中 

 On 仪器自检正常但未运行 
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 闪动 仪器自检失败 

Run Off 仪器未运行 

 On 仪器运行并采集数据 

 闪动 操作故障 

 

2.1.2 后面板 

 

图 3. ICS-90 后面板 

① 电源开关 

② USB 接口 

③ 连接状态指示灯 

LED 指示灯 状态 说明 
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Link On ICS-90 与 Peaknet 6.4 建立联系 

 闪动 ICS-90 与 Peaknet 6.4 传输数据 

 Off ICS-90 与 Peaknet 6.4 未建立联系 

 

④ TTL 输出接口 

用于控制 AS40 自动进样器 

⑤ 管路连接 

淋洗液管，再生液管，电导池出口管，气路管，废液管。 

 

2.1.3 内部结构 

 
图 4. ICS-90 内部结构示意图 

① DS5 型检测稳定器 

DS5 包含一个流动电导池。两片 316 型不锈钢电极被密封在

PEEK 池体中。温度的变化对溶液的电导值有直接的影响。实验室
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的空调可以造成基线缓慢的、有规律的波动，这将影响分析的重

现性，在高电导时影响更甚。 

 

图 5. DS5 示意图 

离子色谱中，抑制淋洗液的电导降低了温度变化的影响，而

温度补偿又进一步改善了基线的稳定性。将电导池放在 DS5 热稳

定器中，恒定的温度（40℃）对电导的影响减至最小。 

 

② MMS III 型抑制器 

MMS III 型抑制器可以降低淋洗液的背景电导，增加样品离

子的响应值，进而提高检测灵敏度。 
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图 6. MMS-III 示意图 

 

③ 压力传感器 

压力传感器用于测量泵头出口单向阀的系统压力，显示在

Peaknet 6.4 中。如果压力明显升高，说明流路堵塞；如果压力

明显降低，说明流路中存在泄漏或者气泡。 

 

④ 进样阀 

     进样阀采用电驱动，定量环为 10μL。该阀有两个操作位置：

装样（Load）和进样（Inject）。装样时，淋洗液由泵流经进样阀

进入分离柱，不通过定量管；而样品被注入定量管并保留在里面

直至进样，多余的样品从废液管排出。进样时，淋洗液通过定量

管，将样品冲洗到分离柱中，1分钟后，进样阀由 Inject 状态返
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回 Load 状态。 

 

图 7. 进样阀流路示意图 

 

⑤ 泵 

高压往复泵采用 PEEK 材料，流速可以在 0.5～2.0mL/min 之

间调节。 

 

⑥ 启动阀 

启动阀安装在泵头，用于冲洗气泡。 

 

⑦ 分析柱 

分析柱由填充有离子交换树脂的分离柱和保护柱组成。其中

保护柱还可以吸附有可能污染分离柱的物质。ICS-90 允许使用下

列分析柱： 

 

2.2 流路 
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图 8.流路示意图 

淋洗液从加压储罐流出，由泵输送至压力传感器、阻尼器、

进样阀。样品注入定量环后，进样阀切换至 Inject 位置，淋洗液

与样品混合后进入分析柱、抑制器、电导池，最后流入再生液储

罐。在阴离子分析中，淋洗液的密度比再生液小，再生液从储罐

底部压出送至抑制器；在阳离子分析中，淋洗液的密度比再生液

大，再生液从储罐顶部推出送至抑制器。这种运行方式叫做置换

式化学再生（DCR）。 
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图 9. 置换式化学再生示意图 
 

2.3 Peaknet 6.4 接口 

2.3.1 Peaknet 6.4 的浏览器 

    浏览器相当于 Windows 的资源管理器，用户可以在其中打

开、移动和修改数据文件。 

 

图 10. Peaknet 6.4 的浏览器 
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2.3.2 ICS-90 控制面板 

 

图 11. ICS-90 的控制面板 

控制面板可以监控 ICS-90 的操作，各参数介绍如下： 

Sample 

Datasource：显示色谱数据的储存位置； 

Sequence：显示样品表的名称； 

Sample：显示正在分析的样品名称； 

Elapsed Time：显示分析样品的实际运行时间； 

Run Time：显示总的运行时间。 

Audit Trail：备忘录。 

ICS-90 System 
Connected/Disconnected：显示和控制 ICS-90 与 PeakNet 6.4 的连

接状态 
Conductivity：显示补偿电导值和总电导值,，按 Autozero 按键调

节零点； 
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Pump：显示系统压力和流速（mL/min），On/Off 键用于开关泵。 

Valve：显示和控制进样阀的状态（Inject 或 Load）； 

Plot：显示 ICS-90 的检测信号。 
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3. 操作 

3.1 淋洗液和再生液的制备 

    DIONEX 公司特别推荐对淋洗液进行过滤和脱气，并储存在惰

性气体加压保护的容器中，它有助于防止泵和检测池中产生气泡。 

常用的淋洗液脱气方法有：真空脱气、氦气鼓泡和超声波等。 

使用氦气、氩气或氮气对淋洗液加压，减压阀的压力调节至   

0.2Mpa。气管与淋洗液瓶口处的压力表连接，拔出黑色旋钮，顺

时针调节至 5psi，将黑色旋钮推回原位锁住。 

再生液储罐必须加满，使用过程中不能晃动。 

 

图 12. 淋洗液加压示意图 

 

3.2 样品的制备 

3.2.1 样品的选择和储存 

样品收集在用去离子水清洗的高密度聚乙烯瓶中。不要用强 
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酸或洗涤剂清洗该容器，这样做会使许多离子遗留在瓶壁上，对

分析带来干扰。 

    如果样品不能在采集当天分析，应立即用 0.45μm 的过滤膜

过滤，否则其中的细菌可能使样品浓度随时间而改变。即使将样

品储存在 4°C 的环境中，也只能抑制而不能消除细菌的生长。 

    尽快分析NO2
－
和SO3

－
，它们会分别氧化成NO3

－
和SO4

－
。不含有

NO2
－
和SO3

－
的样品可以储存在冰箱中，一星期内阴离子的浓度不会

有明显的变化。 

 

3.2.2 样品预处理 

    对于酸雨、饮用水和大气飘尘的滤出液可以直接进样分析。

对于地表水和废水样品，进样前要用 0.45μm 的过滤膜过滤；对

于含有高浓度干扰基体的样品，进样前应先通过 Dionex 公司的

OnGuard™预处理柱。 

 

3.2.3 稀释 

    不同样品中离子浓度的变化会很大，因此无法确定一个稀释

系数。很多情况下，低浓度的样品不需要进行稀释。 

    NaHCO3/Na2CO3作为淋洗液时，用其稀释样品，可以有效地减

小水负峰对F
－
和Cl

－
的影响（当F

－
的浓度小于 50ppb时尤为有效），

但同时要用淋洗液配制空白和标准溶液。稀释方法通常是在

100mL样品中加入 1mL浓 100 倍的淋洗液。 
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3.3 操作 

3.3.1 开机 

1. 确认淋洗液和再生液的储量是否满足需要； 

2. 将压缩气瓶的输出压力调节至 0.2Mpa，淋洗液瓶的压力调节

至 5psi； 

3. 打开 ICS-90 后面板的电源开关。 

接通电源后，ICS-90 的泵处于 OFF 状态，进样阀处于 LOAD

状态，DS5 显示当前读数； 

 

3.3.2 启动 Peaknet 6.4 工作站 

 

图 13. Peaknet 6.4 界面 

1.  点击 Start > Programs > PeakNet > PeakNet，进入以上界

面（见图 13）； 

2.  在浏览器中，点击 Dionex Templates > Panel > Dionex_IC 
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> Dionex_ICS-90_System； 

3. 点击 Control > Connect to Timebase，出现以下界面： 

 

图 14. Peaknet 6.4 控制面板 

 

3.3.3 运行前的准备工作 

1.  在 ICS-90 的控制面板中开泵； 

2.  清洗泵头； 

3.  平衡系统约 30 分钟，点击 Autozero，补偿背景电导，调节

零点。 

注意：如果 ICS-90 开机后 6 小时未进行采样，泵将进入低流速

模式。 

4. 在浏览器中，点击 File > New，选择 Program File，按 OK

键，根据提示编辑程序文件； 

5. 在浏览器中，点击File > New，选择Sequence(Using Wizard)，

按 OK 键，根据提示编辑样品表； 
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6. 在浏览器中，点击 Batch > Start > Add，选择需要运行的

样品表，按 Start 键 

 

3.3.4 进样 

1.  注射器进样； 

2.  真空抽样； 

3.  AS40 自动进样器进样。 

 

3.4 维护 

× 检查各组件连接处有无泄漏并及时清洗。 

× 检查废液桶的含量并及时倒空。 

× 检查泵头与泵体连接处有无泄漏。正常操作造成的磨损会导致

柱塞密封圈的泄漏，严重时可能污染泵的内部，影响正常操作。 
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4. 故障指南 

4.1 报警 

  × 高压报警 

ICS-90 的最大系统压力为 3000psi，超过此极限 0.5 秒，

Peaknet 6.4 自动停泵并出现以下提示： 

The system pressure has exceeded the limit. 

排除方法： 

     1. 检查流路是否有堵塞点并予以解决； 

     2. 重新开泵。 

 

  × 低压报警 

系统压力低于 500psi 时，Peaknet 6.4 自动停泵出现以下

提示： 

The pump has lost prime. 

排除方法： 

1. 检查淋洗液储罐是否排空； 

2. 检查流路是否泄漏； 

3. 排气泡； 

4. 重新开泵。 

 

  × 进样阀错误 

如果进样阀切换失败，Peaknet 6.4 将出现以下提示： 

Load/inject valve error. 

排除方法： 
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1. 在 Batch 菜单中停止样品表的运行 

2. 重新启动 ICS-90； 

3. 在 Peaknet 6.4 的控制面板中点击 Manual Override，

手动切换进样阀； 

4. 恢复操作。 

 

  × 电导值过高 

ICS-90 开机时，有可能出现此情况；如果运行时出现此情

况，Peaknet 6.4 将出现以下提示： 

Conductivity exceeds limit. 

排除方法： 

1. 检查配制淋洗液和再生液的去离子水的电导是否小于

1.0μS； 

2. 检查淋洗液和再生液的浓度及有效期； 

3. 关泵，将分离柱出口与 DS5 电导池的进口直接连接； 

4. 开泵运行 5分钟； 

5. 关泵，将 MMS-III 水化 5分钟； 

6. 恢复管路，重新开泵。 

 

4.2 溶液泄漏 

 × 接头泄漏 

    拧紧接头，必要时进行更换。 

 × 管路破损 

    更换管路和接头。 
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 × 废液管安装不当 

    检查废液管有无扭曲、缠绕的现象并予以排除。 

 × 单向阀松动 

    拧紧单向阀。不要拧得过紧。 

 × 泵头松动 

    拧紧泵头的定位螺栓。不要拧得过紧。 

 × 柱塞垫片损坏 

    更换垫片或柱塞。 

 × 压力传感器泄漏 

如果压力传感器的接头损坏，更换接头。 

× 泵头废液阀泄漏 

拧紧废液阀（不要拧得过紧）；如果仍然泄漏，更换废液阀

的 O型圈。 

 × MMS III 泄漏 

    查阅 MMS III 使用手册。 

 × DS5 泄漏 

    检查 DS5 的废液管、反压管及其它管路的流向是否有误。 

 

4.3 泵清洗困难 

 × 淋洗液瓶中无溶液或未连接淋洗液管路 

    注满淋洗液瓶，将泵的进口与淋洗液瓶相连。 

 × 淋洗液瓶未加压 

    连接淋洗液瓶的气路后加压。 

 × 单向阀堵塞 
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    清洗或更换单向阀。 

 × 泵泄漏 

    更换柱塞垫片。 

 

4.4 泵无法启动 

  × 检查 ICS-90 的电源连接和保险丝。 

  × 检查 USB 的连接情况。 

 

4.5 无溶液流出 

 × 泵头内有气泡。 

    排气泡。 

 × 柱塞折断 

    更换柱塞。 

 

4.6 没有溶液流动 

 × 泵没有清洗 

    清洗泵。 

 × 单向阀污染 

    清洗或更换单向阀。 

 × 柱塞损坏 

更换柱塞。 
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4.7 系统压力过高 

  × 流路中有堵塞处 

     逐段检查流路，确认接头是否拧得过紧。 

  × 接头损坏 

     更换接头 

  × 流速过快 

     1 检查流速设置是否正确 

     2 测量泵的实际流速，必要时进行校正。 

  × 柱垫片堵塞 

     更换保护柱进口垫片。 

  × 分离柱污染 

     清洗分离柱。 

  × 进样阀堵塞 

     查阅进样阀使用手册。 

     

4.8 鬼峰 

   鬼峰是色谱图中非正常出现的峰。如果它与样品峰共淋洗，将

造成峰高或峰面积的不重现。 

  × 进样间隔时间短 

     等待前一次进样完全淋洗结束后，再进行下一次分析。 

  × 定量管清洗不充分 

     进样前，用 10 倍于定量管体积的去离子水或样品冲洗。 

  × 进样阀故障 

     查阅进样阀使用手册。 
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4.9 峰高或保留时间不重现 

  × 分离柱过载 

     1. 稀释样品； 

     2. 更换小体积定量管。 

  × 溶液泄漏 

     检查并消除泄漏。 

  × 定量管未充满 

     1. 重新进样直至有样品自废液管流出；  

     2. 检查注射器，如有损坏予以更换。 

 

4.10 保留时间或选择性异常 

  × 淋洗液被污染或浓度不对 

     采用高纯度试剂或 18MΩ的去离子水配制淋洗液。 

  × 样品被污染或分解 

     处理和储存样品时采取适当的防范措施。 

  × 分离柱被污染 

     清洗或更换分离柱。 

  

4.11 DS5 无响应值 

  × DS5 安装不当  

重新检查管路连接。 
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4.12 DS5 响应值过高 

  × 抑制器没有抑制 

     参考 MMS-III 说明书。 

  × 样品浓度高 

     稀释样品。 

  × 淋洗液或再生液有问题 

     重新配制。 

  × 池电极工作异常 

校正电导池。 

  

4.13 基线漂移或噪音大 

  ×流路有泄漏 

     检查流路，排除泄漏点。 

  × 泵无法正常启动 

     重新启动泵。 

  × 环境温度变化大 

     打开 ICS-90 前门通风。 

  × 改变操作参数后系统未完全平衡 

     延长开始分析前的系统平衡时间。 

  × 电导池中有气泡 

     检查反压管的安装是否正确。 

  × MMS 的操作条件不当 

     查阅 MMS 的操作手册。 
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5. 维修 

5.1 自检与校正 

PeakNet 6.4 提供的无忧面板可以对 ICS-90 的压力传感器

和电导池进行校正。 

在浏览器中，点击 Dionex Templates > Panels > Wellness 

> Dionex_ICS-90_wellness.pan，进入以上界 

 

图 15. Peaknet 6.4 校正面板 

 

System Status: ICS-90 指示灯显示与 Peaknet 6.4 的连接状

态； 

ICS-90 的序列号显示在指示灯的右侧； 

Calibration 或 Diagnostic 变绿说明该过程

正在进行中。 

Audit Trail: 备忘录 

System: 显示系统压力和电导值（ECD）。 

Calibration: Pressure Transducer 
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显示补偿值、斜率和上一次校正的时间； 

在 Measured 中输入测量值； 

点击 Calibrate Offset 或 Calibrate Slope

键校正压力传感器。 

Conductivity Cell 

显示补偿值、斜率和上一次校正的时间； 

点击 Calibrate Offset 或 Calibrate Slope

键校正压力传感器。 

Diagnostic: 显示上一次校正的压力和电导值的变化、最大

值和最小值； 

点击 Start/Stop 键开始/结束 DS5 的校正； 

选择 Dummy Cell 后点击 Start 键，校正模拟

电导池。 

 

5.1.1 校正压力传感器 

    开始校正前 12 分钟，在 Peaknet 6.4 的控制面板中点击

Manual Override 键几次，去除定量管中的气泡。 

1. 停泵，打开废液阀； 

2. 打开 Peaknet 6.4 中的“ICS-90 Wellness Panel”； 

3. 在”pressure transducer”下点击“Calibrate Offset”,

稍等片刻，新的补偿值将出现在屏幕中； 

4. 关闭废液阀； 

4. 在泵的出口与压力传感器之间接入一个压力表，开泵，等待

压力稳定后将此数值输入“measured”中； 
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5. 在”pressure transducer”下点击“Calibrate Slope”,

稍等片刻，新的补偿值将出现在屏幕中； 

 

图 16. ICS-90 内部结构 

 

5.1.2 校正电导池 

安装新的电导池或使用 6 个月后，应对其进行校正。常规分

析不需进行此项操作。 

校正电导池前需要进行以下准备工作： 

① 1.0mM KCl 溶液（0.07456g KCl 定容至 1L）； 

② 1000psi 的反压管（P/N 049715） 

1.  打开 Peaknet 6.4 中的“ICS-90 Wellness Panel”； 

2.  拆除 DS5 的固定螺丝； 

3.  5~10 分钟后，在“conductivity cell”下点击“Calibrate 

Offset”； 

4.  将 DS5 复位，泵的出口管线与电导池进口之间连接 1000psi

反压管； 

 29 



www.sepublog.com     ICS-90 离子色谱仪操作手册（戴安公司提供） 

5.  泵送 1.0mM KCl 溶液，稳定电导值 5~10 分钟； 

6.  在“conductivity cell”下点击“Calibrate Slope”,稍等

片刻，新的校正值将出现在屏幕中； 

7.  校正结束后，电导读数应为 147.00+_2μS/cm，电导池校正

常数在 130~190 之间； 

8.  用去离子水冲洗管路至电导值接近于零，恢复正常流路。 

 

5.2 更换管路和接头 

管路规格(内径) P/N 颜色 用途 

0.005in 044221 红 连接阻尼器和进样阀 

0.010in 042690 黑 连接各个组件 

0.012in 048904 白 连接进样口和进样阀 

0.075in 044777 绿 废液管 

                   表 5－1. 管路的种类 

  

5.3 更换定量管 

样品峰的响应值与样品的浓度和进样体积成正比。用户可以

通过改变定量管的大小来改变进样的体积。 
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图 17. 进样阀流路图 

1. 停泵，打开 DX－80 的前门； 

2. 从进样阀的第 1、4孔之间拆卸定量管； 

3. 不同体积的定量管可以根据原有规格截取或延长； 

4. 在进样阀的第 1、4孔之间安装新的定量管。 

  

5.4 排除流路中的阻塞点 

1. 以正常流速泵送淋洗液通过各组件； 

2. 依照流路图逐一拧松各组件之间的接头，压力变化 

   异常处即为阻塞点。 

 

5.5 更换单向阀 

1. 关机，拔掉电源线； 

2. 拆除连接单向阀的管路； 

3. 从泵头拆除单向阀； 

4. 安装新的单向阀，泵头底部是进口单向阀(P/N 047660)，顶部 

  是出口单向阀(P/N 047661)； 

警告：过分拧紧单向阀将损坏泵头和单向阀； 

5. 重新连接单向阀的管路，清洗泵。 

 31 



www.sepublog.com     ICS-90 离子色谱仪操作手册（戴安公司提供） 

 

图 18. 泵头结构示意图 

 

5.6 更换柱塞密封圈 

1.  关机，拔掉电源线； 

2.  拆除连接单向阀的管路； 

3.  用力顶住泵头防止其外弹，拆除两颗螺帽； 

警告：拆卸泵头时的任何横向移动将损坏柱塞； 

6. 缓慢松开泵头，使其与底座分离，再沿直线抽出泵 

  头，与柱塞和导向管分离； 

5.  泵头前面向下放在工作台上，除去导向环； 

6.  拆下损坏的密封圈； 

7.  拆下支撑垫圈上的 O型圈和密封圈； 

8.  安装新的密封圈(P/N 055870)； 

9.  将新的 O型圈(P/N 035776)放入密封圈(P/N 036901)中， 

    再将它们放回支撑垫圈中； 

10. 将支撑垫圈放入泵头，再放入导向环； 

11. 从底座中取出弹簧、导向管和柱塞，检查底座中是否有液体

泄漏或腐蚀，清除后重新安装柱塞； 
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12. 将泵头对准定位螺栓，柱塞对准密封圈，弹簧对准 

    导向管； 

警告：安装泵头时的任何横向移动都有可能损坏密封 

      圈、支撑垫圈和柱塞。 

13. 将泵头推入底座中，拧紧螺帽； 

14. 重新连接单向阀的管路，通电，开机，清洗泵。 

 

图 19. 柱塞组件示意图 

 

5.7 更换柱塞 

1. 关机，拔掉电源线； 

2. 拆除连接单向阀的管路； 

3. 用力顶住泵头防止其外弹，拆除两颗螺帽； 

警告：拆卸泵头时的任何横向移动将损坏柱塞； 

4.  缓慢松开泵头，使其与底座分离，再沿直线抽出泵头，与柱

塞和导向管分离； 

5.  从泵头中拆除柱塞导向环、弹簧、弹簧导向管和柱塞； 

6.  如果柱塞损坏，应同时更换密封圈和支撑垫圈； 

7.  拆除旧柱塞上的保留环(P/N 035010)，安装到新柱塞 

    (P/N 036904)上； 

8.  将弹簧定位环套在柱塞上； 

9.  将柱塞组件放回底座中； 
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10. 将弹簧套在柱塞上； 

11. 泵头安放在底座之前，将柱塞对准密封圈，弹簧对 

  准导向管； 

警告：安装泵头时的任何横向移动都有可能损坏密封 

      圈、支撑垫圈和柱塞。 

 

5.8 更换废液阀的 O 型圈 

1. 关机； 

2. 拧下压力传感器的废液阀； 

3. 用锋利的刀片割断 O型圈，注意不要损坏废液阀； 

4. 将新的 O型圈(P/N 035776)推入槽中； 

5. 在 O 型圈表面涂少许润滑脂； 

警告：过多的润滑脂将污染淋洗液。 

6. 将废液阀拧回原位。 

警告：过度拧紧将损坏废液阀和压力传感器。 

 

20. 泵头组件示意图 

 

5.9 安装电导池 

1. 关闭电源，拔掉电源线，打开前门； 
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2. 拆卸 DS5 进出口的管路和顶部的两个螺栓； 

3. 更换新的 DS5（P/N 057290）； 

4. 恢复管路，重新操作。 

 

5.11 安装抑制器 

1. 停泵，打开前门； 

2. 拆卸抑制器的四个接头； 

3. 拆卸抑制器左侧的螺栓，向左平推拆卸抑制器； 

4. 安装新的抑制器，恢复操作。 

 

5.12 更换保险丝 

1. 关机，拔掉电源线； 

2. 拔出插座上方的保险盒（见图 17）； 

3. 同时更换两个 3.15A 的保险丝(P/N 954745)。 

 

图 21. 保险盒示意图 
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附录 A. 技术指标 

A.1 电路 

      主电源：220～240V/50Hz 

      保险丝：两个 3.15A 速熔保险丝(P/N 954745) 

 

A.2 物理参数 

    外形尺寸：32.125cm 高×23.23cm 宽×39.73cm 深 

        重量：14kg 

 

A.3 环境要求 

    操作温度：10C° ～ 35C° 

    操作湿度：5％ ～95％ 

  载气及压力：氦气、氩气、氮气、压缩空气 

              0.55～0.83Mpa(80～120psi) 

    操作压力：21Mpa(3000psi) 

 

A.4 泵 

        型号：单柱塞往复泵，流路采用惰性材料 PEEK 

    操作方式：体积恒定 

    流速范围：0.5～2.0mL/min 

 

A.5 阻尼器 

        型号：PEEK 管式阻尼器（0.030in ID） 
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    最大压力：21Mpa(3000psi) 

 

A.6 检测器 

        范围：0～500μS 

      池驱动：8KH 方波 

自动补偿范围：－999～999μS 

    操作方式：Peaknet 6.4 软件通过 USB 操作 

 

A.7 电导池 

      标准池：    池体－PEEK 

                  电极－316 型不锈钢 

                池体积－1μL 

              最大压力－300psi(2.0MPa) 

 

A.8 阀 

      进样阀：电驱动、双位六通阀（PEEK 材料流路） 

 

A.10 死体积 

  系统死体积：< 5mL 
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附录 B 安装 

B.1 准备工作 

1. 实验室的环境和载气、电源应满足附录 A的要求； 

2. 实验台的高度应保证操作者对前面板具有最佳视觉效果； 

3. ICS-90 后部至少应保留 15cm 空间； 

4. ICS-90 底部的固定螺丝在仪器使用前应予以拆除，拆下的螺

丝安装在右侧的专用保留孔中备用。 

 

图 22. 固定螺丝示意图 

 

B.2 安装 PeakNet 6.4 

1. 接通计算机电源，确认操作系统 Windows2000，显示属性 16

色，1024X768（推荐值）； 

2. 在光驱中放入 PeakNet 6.4 的程序光盘，点击 Launch PeakNet 

6 Setup； 
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B.3 ICS-90 的连接 

 

图 23. 一台 ICS-90 与个人计算机连接示意图 

 

图 24. ICS-90 的后面板 

 

图 25. 多台 ICS-90 与计算机连接示意图 
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B.4 连接电源 

    在确认电压和频率与仪器的要求一致后，用电源线（IEC 320 

C13）连接后面板的插座与接有地线的主电源。 

警告：不许使用没有地线的电源插座！ 

    确认计算机已经安装 PeakNet 6.4 后，打开 ICS-90 的电源。 

 

B.5 设置 PeakNet 6.4 

1. 安装“加密狗”； 

2. 点击 Start > Programs > PeakNet > Server Monitor > Start； 

 

图 26. 服务器的 Evaluation 模式 

3. 点击 Start > Programs > PeakNet > Server Configuration； 

4. 点击 Edit > Properties，选择“Dongle”，输入 Key Code，

按 OK 键； 
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图 27. 初始化设置 

5. 检查 Server Monitor，确认“PeakNet Server is running 

idle”，选择 Close。 

 
图 28. 服务器的正常状态 

 

B.6 创建 Timebase 

1. 在 Server Configuration 中，点击 Edit > Add Timebase。

在时钟状图标的后面输入 ICS-90； 
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图 29. 创建 Timebase 

2. 点击 Edit > Add Device，选择 Dionex ICS-90 System，按

OK 键。 

 

图 30. 添加设备对话框 

3. 在 General 窗口中，Live Mode 为默认选项，从右侧下拉箭头

处选择 ICS-90 的序列号，存盘退出。 
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图 31. ICS-90 的初始化设置 

 

B.7 ICS-90 与 PeakNet 6.4 联机 

 

图 32. PeakNet 6.4 的主窗口 
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1. 点击 Start > Programs > PeakNet > PeakNet > File > Browser 

Dionex Templates > Panels > Dionex_IC >  

Dionex_ICS_90_System； 

2. 如果 ICS-90 与 PeakNet 6.4 未能自动联机，点击 Control > 

Connect to Timebase； 

 

图 33. ICS-90 的控制面板（未联机） 

3. 点击”My Computer”前面的”+”，选择 ICS-90，按 OK 键。 
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图 34. Timebase 的连接 

 

图 35. ICS-90 的控制面板（ 已联机） 

4. 检查 ICS-90 前面板的 LED 指示灯，确认联机成功。 
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图 36. ICS-90 的联机指示灯 

 

B.8 连接废液管 

 
图 37. 反压管连接示意图 

    将废液管的出口放入废液桶，其位置不应高于实验台。 

 

B.9 连接气路 

    用内径 3mm(0.062in)的透明塑料管连接淋洗液压力表，另一

端与压缩气瓶相连。其输出压力调节至 0.2Mpa，淋洗液压力表的

压力调节在 5psi。 
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图 38. 淋洗液压力表 

 

B.10 连接淋洗液瓶和再生液瓶 

 

图 39. 淋洗液瓶和再生液瓶连接示意图 

 

B.11 安装色谱柱和抑制器 
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图 40. ICS-90 的组件板 

根据色谱柱的流向箭头、PEEK 管和抑制器的标示安装各个组

件。 

 

图 41. ICS-90 的组件安装示意图 
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B.12 清洗泵 

1. 在淋洗液瓶中注满所需溶液； 

2. 插入淋洗液管，拧紧瓶盖，加压； 

3. 拧松泵头的废液筏，开泵，淋洗液经泵直接排入废液； 

4. 清洗 2～3分钟，确认淋洗液瓶与泵之间的管路中没有气泡； 

6. 拧紧废液阀，恢复操作。 

注意：过度拧紧废液阀将损坏泵头！ 

 

图 41. ICS-90 的内部结构 

 

B.13 设定泵的流速 

1. 开泵，打开 ICS-90 的前门，拔出流速调节旋钮，缓慢转动，

待控制面板中的压力显示处于正常范围后，将流速调节旋钮推

回正常位置； 

注意：控制面板中的压力显示有大约 10 秒钟的滞后，流速显示

仅为记录值，不能实时变化。 
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2. 采用容量法和重量法可以准确测定流速； 

 

图 42. 容量法测定流速 

3. 在 PeakNet 6.4 的控制面板中，点击 Control > Command > 

Pump_ECD > Measured Flow Rate，输入测量值后点击 Execute 

> Close 退出。 

 

图 43. 输入流速测量值 
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附录 C 常见问题 

1. 多长时间进行标准曲线的校正? 

六个月。 

 

2. 保留时间为什么会改变? 

泵的流速不稳定或分离柱被污染。 

 

3. 长时间更换淋洗液? 

   2～3 周。 

 

4. 如何启动 Peaknet 6.4? 

   Start＞Programs＞PeakNet＞PeakNet。 

 

5. 如何删除数据? 

选中需要删除的数据，点击 File＞Delete。 

 

6. 如何备份数据? 

选中需要备份的数据，点击 File＞Export/Backup。 

 

7. 如何关机? 

在 Peaknet 6.4 的控制面板中停泵，关闭 ICS-90 后面板的电

源开关。 
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